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1 Start Successfully 
  

1.1 About the Manual 
This manual is intended for all users who want to learn how to use Nero DiscSpeed. It is 
process-based and explains how to achieve a specific objective on a step-by-step basis. 

To make best use of this documentation, please note the following conventions: 

 Indicates warnings, preconditions or instructions that have to be pre-
cisely followed. 

 Indicates additional information or advice. 

1. Start … The number at the beginning of a line indicates a prompt for action. 
Carry out these actions in the order specified. 

 Indicates an intermediate result. 

 Indicates a result. 

OK Indicates text passages or buttons that appear in the program inter-
face. They are shown in boldface. 

(see…) Indicates references to other chapters. They are executed as links and 
are shown in red and underlined. 

[…] Indicates keyboard shortcuts for entering commands. 
 

 
  

1.2 About Nero DiscSpeed 
Nero DiscSpeed tells you the speed of the available CD/DVD drives. Results can be viewed 
either as a graph or as a test log. Nero DiscSpeed also creates special test media for data 
and audio. 
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2 Starting The Program 
To start Nero DiscSpeed via Nero StartSmart, proceed as follows: 

 1. Click the Nero StartSmart icon. 
 The Nero StartSmart window is opened. 

 2. Click the  button. 

 The list of Nero applications is displayed. 

 
Nero StartSmart window 

 3. Select the Toolbox > Nero DiscSpeed entry in this selection list. 
 The Nero DiscSpeed window is opened. 

  You have launched Nero DiscSpeed via Nero StartSmart. 
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3 Main Screen 
The Nero DiscSpeed main screen is the starting point for all actions that you perform using 
Nero DiscSpeed. 
The drop-down menu lists the optical drives available on the computer using their exact 
model designations. It also displays the version number of the firmware installed on the 
drive. 
You can switch between tabs within the main screen. These tabs are used to carry out the 
different tests and to display information regarding them. 

 
Main Screen 

The menu bar in the main screen has four menus. 

The following entries are available in the File menu: 

Load Results Contains the following two sub-entries: Load Single File and Database. 
Load Single File: Loads a saved test file. 
Database: Loads several files at the same time. This way, you can com-
pare test results and/or the efficiency of optical drives. 
Only test files saved as binary files with the extension *.dat can be 
loaded again. 
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Save Results Contains the following three sub-entries: Binary (.dat), Text (.csv), and 
HTML. 
Binary (.dat): Saves the test results as a binary file. Only test files saved 
as binary files with the extension *.dat can be loaded again. Use this 
format if you want to open the test results in Nero DiscSpeed or in the 
Nero DiscSpeed database and compare them. 
Text (.csv): Saves the test results as a text file that you can open with 
any text editor. 
HTML: Saves the test results in a diagram that you can open with any 
Web browser. In the Options window, under the Save navigation entry, 
you can define how much data will be saved in the file. If the Include 
status check box is enabled, the diagram and all other test results are 
saved; if it is cleared, only the graph is saved. 

Capture to 
clipboard 

Copies a snapshot of Nero DiscSpeed to the clipboard. The results in all 
further displays are lost.  
You must save the snapshot before removing the disc you are testing 
from the optical drive. Otherwise the image will be deleted from the clip-
board. 

Capture to file The Save as dialog appears. Opens the Save As window, where you can 
save the snapshot on your hard drive. 

Options Opens the Nero DiscSpeed - Options window, where you can define 
settings for the user interface, for the save function, and for various tests.  

Exit Exits Nero DiscSpeed. 
 

The following entries are available in the Run Test menu: 

Selected Starts a standard test series. All standard tests that you selected in the 
Nero DiscSpeed - Options window, under the Standard Tests naviga-
tion entry, are run. 

All Starts the standard test series. All the standard tests that are listed in the 
Nero DiscSpeed - Options window, under the Standard Tests naviga-
tion entry, are run. 

Transfer Rate Starts the transfer rate test.  

DAE Quality Starts the DAE quality test.  

Access/Seek 
Times 

Starts the access/seek times test.  

CPU Usage Starts the CPU usage test.  

Burst Rate Starts the burst rate test.  
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Spin Up/Down Starts the spin up/down test.  

Load/Eject Starts the load/eject test.  

Create Data 
Disc 

Starts the create data disc test.  

 

The following entries are available in the Extra menu: 

Advanced DAE 
Quality Test 

Contains the following three sub-entries: Create Test CD, Run Test, 
and Error Test. 
Create Test CD: Opens the Nero DiscSpeed - DAE Test Disc win-
dow, where you can burn a special test disc in order to run the ad-
vanced DAE quality test. 
Run Test: Opens the Advanced DAE Quality Test window, where 
you can run the advanced DAE quality test with the help of a pre-
viously created test disc. 
Error Test: Contains the Create Image and Run Test sub-entries. 
Create Image: Opens the Nero DiscSpeed - Advanced DAE - 
Create Image window, where you can create an image file of the 
test disc. You need a test disc type A-BEX (TCD-714R, TCD-721R, 
or TCD-726)  
Run Test: Opens the Nero DiscSpeed - Advanced DAE Error Cor-
rection Test window, where you can read the data from an A-BEX 
disc and compare it with the data of the created image file. 

Overburning test Opens the Nero DiscSpeed - Overburning Test window, where you 
can simulate the overburning test. 

Erasing a Disc Opens the Nero DiscSpeed - Erase window, where you can erase 
data from rewritable discs. 

Bit Setting Opens the Nero DiscSpeed – Bit setting window, where you can 
change the bit settings for a DVD recorder. 

 

The following entries are available in the Help menu: 

Help Opens the Help Information window, where you can download the 
manual for Nero DiscSpeed from the Nero website.  

About Opens the About Nero DiscSpeed window, where you can find the 
exact version number of Nero DiscSpeed. 

 

The following buttons are available: 

 Opens the Nero DiscSpeed - Options window, where you can de-
fine settings for the user interface, for the save function, and for vari-
ous tests. 
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Start Starts the test. 
The test that is started depends on the selected tab. 

Stop Stops the test in progress. 

Exit Closes Nero DiscSpeed. 
 

The following tabs are available: 

Benchmark Displays the Benchmark tab. Here you can run the standard tests 
offered by the program. This is also where the results are displayed. 

Create Disc Displays the Create Disc tab. Here you can run an advanced test for 
writing to disc. 

Disc Info Displays the Disc Info tab, where you can find detailed information 
on the disc currently in the optical drive. 

Disc Quality Displays the Disc Quality tab. Here you can run a scan to test the 
quality of burned discs. 

Scan Disc Displays the ScanDisc tab. Here you can run a further quality test. 
 

 

 
Whether the Disc Quality tab is available depends on the recorder that is in-
stalled. 

See also 
  Transfer rate → 14 
  DAE Quality → 16 
  Access/Seek Times → 16 
  CPU Usage → 17 
  Burst Rate → 17 
  Spin Up/Down → 17 
  Load/Eject → 17 
  Create Data Disc (Classic Version) → 18 
  Additional Test - Advanced DAE Quality → 35 
  Additional Test - Overburning → 44 
  Erasing a Disc → 49 
  Bit Setting → 50 
  Benchmark Tab - Standard Tests → 11 
  Disc Info → 23 
  Nero DiscSpeed Options Window → 52 
  Saving Test Data → 47 
  Loading Test Data → 47 
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4 Benchmark Tab - Standard Tests 
All standard tests are run in the main screen on the Benchmark tab. You can run tests indi-
vidually or combined into a test series. 
The following standard tests are available: 

  Transfer rate 
  DAE quality 
  Access/Seek Times 

  CPU usage 
  Burst Rate 

  Spin Up/Down 
  Load/Eject 
  Create Data Disc (Classic Version) 

 
Standard Tests - Benchmark tab 

You will find general information on the disc that is inserted in the drive in the Disc Type 
area, to the right of the graph. The following display panels are available: 

Type Shows the disc type of the disc in the drive. 

For some tests, the results achieved are conditional upon the disc type. 

Length Shows the storage capacity of the disc in the drive. In MB for CD's, in GB for 
DVD's. 
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4.1 Running an Individual Standard Test 
The following requirement must be fulfilled: 

 ► The Benchmark tab is selected in the main screen. 
To start an individual test, proceed as follows: 

 1. If there are several optical drives available, select the one you want in the drop-down 
menu. 

 2. Insert an appropriate disc into the optical drive. 

 3. Click the Run Test menu. 
 The Run Test menu is opened. 

 
Standard Test - Selection 

 4. Select the desired test. 
 The Spin Up Drive window is displayed while the test is being prepared. The window 

is then closed automatically. 
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 The test is run. You can follow the individual steps of the test process in the display 
area under the graph. 
You can cancel a running test at any time by clicking the Stop button. 

  You can now see the result of the test in the graph and the relevant displays and save 
it. 

See also 
  Saving Test Data → 47 
  

4.2 Running a Standard Test Series 
The following requirement must be fulfilled: 

 ► The Benchmark tab is selected in the main screen. 
To start more than one test in succession, proceed as follows: 

 1. If there are several optical drives available, select the one you want in the drop-down 
menu. 

 2. If you want to change the standard tests: 

 1. Click the  button. 

  The Nero DiscSpeed - Options window is opened. 
 2. Click the Standard Tests navigation entry. 

  The Standard Tests screen is displayed. 

   

 3. Select the check boxes for the tests that you want to run and clear the check boxes for 
all tests that you do not want to start. 

 4. Configure further settings for the enabled tests as desired (under the relevant navigation 
entries) and click the OK button. 
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 3. Insert an appropriate disc into the optical drive. 

 4. Click the Start button. 
 The Spin Up Drive window is displayed while the test is being prepared. The window 

is then closed automatically. 

 

 The test is run. You can follow the individual steps of the test process in the display 
area under the graph. 
You can cancel a test in progress at any time by clicking the Stop button. 

  You can now see the result of the test in the graph and the relevant displays and save 
it. 

 

See also 
  Saving Test Data → 47 
  Nero DiscSpeed Options Window → 52 
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4.3 Transfer rate 
The Transfer rate test measures the read speed of data, i.e. the speed at which data is read 

from a disc. If the disc inserted is blank, the test measures the write speed. 

This test is suitable for testing an optical drive and for verifying the readability of burned 
discs (CDs or DVDs).  
The results are displayed in the form of two curves in the graph. By default, the read speed 
is shown as a green line, and the rotational speed or angular velocity of the disc is shown as 
a yellow line. 
The horizontal scale shows the storage capacity values (in MB for CD's and in GB for 
DVD's). The vertical scales show the read speed on the left and the rotational speed on the 
right in RPM x 1000. 

With a dual layer disc, the graph shows two additional vertical lines: a red one for the full 
capacity of the disc and a pink one that divides the representation into two sections. Each 
section shows the measurement for one layer. 
In addition, the test results are displayed in the Speed area, to the right of the graph. 
 

 
If your main interest is testing optical drives, it is a good idea to use discs that are 
slightly damaged. 

 

The following display panels are available in the Speed area: 

Current/Average Shows the varying speed over the course of the test. The average 
speed is displayed here when the test is finished. 

Start Shows the lowest speed determined over the course of the test. In a 
normal curve, the lowest speed is also the start speed. In an uneven 
curve, the lowest recorded speed is displayed here as the minimum 
value. 

End Shows the highest speed determined over the course of the test. In a 
normal curve, the highest speed is reached at the end. In an uneven 
curve, the highest recorded speed is displayed here as the maximum 
value. 

Type Shows the type of rotational speed. 
A disc can be read with the following types of rotational speed: 
CAV (constant angular velocity): With constant angular velocity, the 
disc rotates at a constant speed, which means the inner tracks travel 
at the slowest linear velocity. The linear velocity increases as you 
move away from the center towards the outer edge. The data rate 
remains constant while the data density decreases away from the 
center of the disc.  
CLV (constant linear velocity): With constant linear velocity, the 
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rotational speed of the disc decreases as the laser moves away from 
the center of the disc. As a result, both the read speed and the data 
density and rate remain constant in all areas of the disc. 
ZCLV (zone CLV): If a disc is divided into several CLV zones, each 
one of them can be read and above all burned as separate logical 
areas by using CLV. 16x speed is a characteristic value for the inner-
most zone of a CD, after which the speed can be increased in stages. 
PCAV (partial CAV): In a combination of CAV and CLV, CAV tech-
nology is used in the inner area of the disc. When a certain linear ve-
locity is reached, CLV technology is switched to towards the outer 
edge of the disc. In other words, the rotational speed remains constant 
until the read speed has reached a maximum value; the read speed 
then remains at a constant level while the rotational speed decreases. 

 

See also 
  Transfer Rate Navigation Entry → 56 
  Disc Quality Entry → 62 
  

4.4 DAE Quality 
The DAE quality test comprises two partial measurements. The DAE quality test results are 
displayed in the DAE Quality area. 
First, audio areas from three different points on the disc are read and stored on the hard 
drive. The same areas are read again and compared with the buffered data. The DAE quality 
is awarded a value between 0 and 10 (perfect quality, no differences) depending on the 
number of differences counted. The determined value is shown on the display panel. 
Next, Nero DiscSpeed checks if the optical drive supports accurate streaming. If the Accu-
rate stream check box is enabled, desired audio files can be precisely located on a disc 
whenever necessary. 
 

 
If your optical drive performs poorly in the test, we recommend that you also ena-
ble a verification feature when ripping CD's. 

  

4.5 Access/Seek Times 
The Access/seek times test measures the access or seek times of optical drives for discs 
inserted in the drive in three partial measurements. The results of all three partial measure-
ments are displayed in the Access times area, to the right of the graph. 
Before starting the test, you can use the options to define whether you want to test the 
access time or the seek time, as well as how many times you want to run the test.  

 

 



Benchmark Tab - Standard Tests 

 Nero DiscSpeed 17 

The following partial measurements are performed for seek or access times: 

Random Moves the read head to a random position on the disc. 

1/3 Moves the read head from the start of the disc over the first third. 

Full Moves the read head from the start of the disc to its logical end, i.e. to the out-
ermost position where data is saved on the disc. 

 

See also 
  Access/Seek Times Navigation Entry → 58 
  

4.6 CPU Usage 
The CPU usage test measures the percentage utilization of the CPU (central processing 
unit) at various read and write speeds (1x, 2x, 4x, and 8x). The results are displayed in the 
CPU usage area, to the right of the graph. 
  

4.7 Burst Rate 
The Burst rate test measures the maximum possible transmission rate from the optical drive 
to the computer. 
Since optical drives are usually connected to the IDE channel of a motherboard with the 
corresponding cable, the test result in this case shows the transmission speed of the IDE 
channel. 
If the optical drive is connected in a different manner, the test is useful nevertheless. You 
can use the result to check whether the connection is fast enough for a high burning speed. 
The result of the measurement is shown in the Interface area, to the right of the graph. The 
value in the Burst rate display panel should always be greater than the maximum speed of 
the optical drive (e.g. greater than 21 MB/s for a DVD burner with 16x write speed). 
 

 
The test results are only meaningful if data from the disc inserted in the drive is 
cached. Since many optical drives do not cache audio data on the hard drive, we 
recommend using data CD's for this test. 

 
  

4.8 Spin Up/Down 
The Spin down test measures how long it takes an optical drive to stop, while the Spin up 
test measures how long it takes before the optical drive can read data again after stopping. 
The shorter the two times, the better the result. Faster optical drives have faster spin up/spin 
down times. 
The results of both measurements are shown at the bottom of the screen, in the display 
area. 
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4.9 Load/Eject 
The Load/eject test measures the time that an optical drive needs to load, detect, and eject 
a disc. 
The time an optical drive needs to load and/or eject a disc should always be roughly the 
same, regardless of the disc type. The duration depends on how quickly the optical drive 
closes the tray and opens it again. 
The time an optical drive needs to detect a disc that is inserted in the drive depends on the 
disc type. It takes longer to detect a multisession disc than a disc containing a single ses-
sion. 
The results of the measurements are displayed at the bottom of the screen, in the display 
area. 
  

4.10 Create Data Disc (Classic Version) 
The Create data disc test is available in its classic version on the Benchmark tab and as an 
advanced version on the Create Disc tab. You can use the classic test to analyze the read 
speed and the rotational speed. You can use the advanced test to also measure the buffer 
level and the CPU usage caused by the optical drive.  

The classic test is run on the Benchmark tab, where the result is also displayed. The graph 
shows the curve for the write speed in this case, and the rotational speed of the disc on re-
quest. 
The classic test is run in accordance with the settings you defined in the options under the 
Transfer Rate navigation entry (see ). 
 

 
If you do not want to show the rotational speed in the graph, disable the Show 
RPM check box in the options under the Transfer Rate navigation entry. 

 

Previously selected binary data is written to a blank disc until the maximum disc capacity is 
reached. The number of files written differs according to the disc type, since a DVD holds 
significantly more data than a CD. 
 

 
If you want to check your data and display the results in the display panel under 
the graph, enable the Verify data check box in the options under the Standard 
Tests navigation entry. 

 

See also 
  Transfer Rate Navigation Entry → 56 
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5 Create Data Disc 
  

5.1 Running the Create Data Disc Test 
The following requirement must be fulfilled: 

 ► The Create Disc tab is selected in the main screen. 
To start the Create data disc test, proceed as follows: 

 1. If there are several optical drives available, select the one you want in the drop-down 
menu. 

 2. Configure the settings you want in the Settings area to the right of the graph. 

 3. Insert a blank disc in the optical drive if you are not running a simulation. 

 4. Click the Start button. 
 The test or burn process is run. You can follow the individual steps of the test process 

in the display area under the graph. 
You can cancel a running test at any time by clicking the Stop button. 

 

 
Always start the test using the Start button. 
As long as you are running this test, the entries in the Run Test menu will be 
grayed out. If you click Run Test > Selected, the test is automatically run on the 
Benchmark tab and the results of the classic version are displayed. 

 

  You can now see the results of the test in the graph and the relevant displays and 
save them. 

See also 
  Saving Test Data → 47 
  

5.2 Creating a Data Disc (Advanced Version) 
The Create data disc test is available as an advanced version on the Create Disc tab and 
as a classic version on the Benchmark tab.  

You can use the classic test to analyze the read speed and the rotational speed. You can 
use the advanced test to also measure the buffer level and the CPU usage caused by the 
optical drive. 
The advanced test is run on the Create Disc tab, and the result is also displayed here.  
The results are displayed on the graph in the form of the following four curves: 

  Writing Speed 

  Rotation 

  Buffer level 
  CPU usage 
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The horizontal scale shows the values for disc capacity (in MB for CD's and in GB for 
DVD's). The vertical scales show the write speed on the left and the rotational speed on the 
right (in RPM x 1000). 

A progress bar between the diagram and the display area shows the burning progress. 

 
Create Disc tab 

You will find general information on the disc that is inserted in the drive in the Disc info area, 
to the right of the graph. The following display panels are available: 

Type Shows the disc type of the disc in the drive. 

ID Shows the media code of the disc. 

Length Shows the recording capacity of the disc in the drive (in MB for CD's and GB for 
DVD's). 
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As a basic principle, all settings defined in the options apply to the standard test 
on the Benchmark tab. All settings affecting the advanced test are configured 
directly on the Create Disc tab.  
The colors in the graph are an exception to this. If you want to change these col-
ors, you can do so in the options under the User Interface navigation entry. 

 

You can define necessary preferences for the test in the Settings area to the right of the 
graph. The following setting options are available: 

Menu 
Speed 

Defines the speed at which the test is run. The available entries in the 
drop-down menu vary depending on the disc in the drive. 

Check box 
Burn image 

If this check box is enabled, Nero DiscSpeed writes an image file that 
you have selected to the recordable disc instead of writing previously 
defined binary data. 

Check box 
Simulate 

If this check box is enabled, Nero DiscSpeed simulates the process to 
create all the test results instead of writing data on the recordable disc. 

 

The test results are also displayed in the Speed, Buffer, CPU Usage, and Progress areas 
to the right of the graph. The following areas are available: 

Speed Shows the partial results of the speed test. 
Current/Average shows the varying speed over the course of the test. 
The average speed is displayed here when the test is finished. 
Start - Shows the lowest speed detected over the course of the test. In 
a normal curve, the lowest speed is also the start speed. In an uneven 
curve, the lowest recorded speed is displayed here as the minimum 
value. 
Type - Shows the type of rotational speed. 
End - Shows the highest speed determined over the course of the test. 
In a normal curve, the highest speed is reached at the end. In an un-
even curve, the highest recorded speed is displayed here as the max-
imum value. 

Buffer Shows the percentage usage of the buffer during the write test, both 
graphically in the bar and numerically beside it. The values for the min-
imum buffer level, the maximum buffer level, and the average buffer 
level are listed below from left to right. These values are continuously 
refreshed over the course of the test. 
If the Show graph check box is enabled, a representation of the buffer 
level is plotted on the graph. The small colored square to the left shows 
the color of the line. You can change this color according to your re-
quirements in the options under the User Interface navigation entry. 



Create Data Disc 

 Nero DiscSpeed 22 

CPU usage Shows the CPU usage during the write test graphically in the bar and 
numerically beside it. The values for the minimum CPU usage, the 
maximum CPU usage, and the average CPU usage are listed below 
from left to right. These values are continuously refreshed over the 
course of the test. 
If the Show graph check box is enabled, a representation of the CPU 
usage is plotted on the graph. The small colored square to the left 
shows the color of the line. You can change this color according to 
your requirements in the options under the User Interface navigation 
entry. 

Progress Position continuously indicates the current position of the read head 
on the disc during the write process. 
Elapsed specifies in minutes and seconds the time elapsed since the 
write process started. 

 

See also 
  Create Data Disc (Classic Version) → 18 
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6 Disc Info 
The Disc Info tab provides detailed information on the disc inserted in the drive. The infor-
mation is displayed on the tab in an area divided into: Basic Information, Extended Infor-
mation, and Raw Data. 

 
Disc Info Tab 

You can customize the display to meet your requirements by using the check boxes under 
the display area. The following check boxes are available: 

Basic information If this check box is enabled, the general information in the 
Basic Information area is displayed. 
If this box is not checked, this information will be hidden. 

Extended Information If this box is checked, the information in the Extended 
Information area will be displayed. 
If this box is not checked, this information will be hidden. 

Raw data If this box is checked, the Raw data will be displayed. 
If this box is not checked, this information will be hidden. 
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Additionally, the following buttons are available under the display area: 

Copy Text Copies all of the information to the clipboard in text format. 

Copy HTML Copies all of the information to the clipboard in HTML format. 
 

You will find general information on the disc in the drive in the Basic Information area. The 
following display panels are available: 

Disc type Shows the disc type of the disc in the drive. 

Book type Shows the book type of the disc in the drive. 

Manufacturer Shows the manufacturer's name. 

MID Show the media identification code (MID). The MID identi-
fies the disc.  

Write Speeds Shows all possible burning speeds for the disc in the drive. 

This information depends on the firmware of the chosen 
optical drive, i.e. different recorders can show different op-
tions for the same disc. 

Capacity Shows the disc capacity both in MSF (mi-
nutes/seconds/frames) and in MB. 
Additional capacity achieved through overburning is not 
incorporated into the calculation. 

 

You will find further information on the disc in the drive in the Extended Information area. 
The following display panels are available: 

Layers Shows the number of available layers on the disc. 

Write strategies Checks the intended use of a disc. Some discs have a designated 
purpose, for example audio CDs, data CD. 

Copyright protection Shows whether or not the disc in the drive is copy-protected. 

Disc status Shows the status of the disc, i.e. whether the disc is still totally 
blank, already finalized or can accept more data. 

 

You will find information on binary data that was previously burned to the disc in the Raw 
Data area. 



Disc Quality 

 Nero DiscSpeed 25 

  

7 Disc Quality 
  

7.1 Running the Disc Quality Test 
The following requirement must be fulfilled: 

 ► The Disc Quality tab is selected in the main screen. 
To start the Disc Quality test, proceed as follows:  

 1. If there are several optical drives available, select the one you want in the drop-down 
menu. 

 2. Insert a disc into the optical drive. 
 

 
If you want to run the detailed test, i.e. test the entire disc, make sure that the 
Quick scan check box is disabled. 

 

 3. Configure the settings you want in the Settings area, to the right of the graph. 

 4. Click the Start button. 
 The Spin Up Drive window is displayed while the test is being prepared. The window 

is then closed automatically. 

 

 The test is run. You can follow the test processes in the areas under the graphs. You 
can cancel the running test at any time by clicking the Stop button. 

  You can now see the results of the test in the graphs and the relevant displays and 
save them. Furthermore, the Disc Quality Test – Statistics window is opened and 
shows the testresults. 

See also 
  Saving Test Data → 47 
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7.2 Disc Quality Tab 
The Disc Quality test is often referred to as Scan, and can be run on the Disc Quality tab. 
You can choose between a quick scan and a complete scan. The quick scan only checks 
defined points on the disc. All other areas are ignored. As a result, it requires less time than 
a complete scan but is less accurate. This test is particularly useful for burned discs. It can 
only be run reliably with a recorder; a simple reader is not sufficient. 
 

 
Whether the Disc Quality tab is available depends on the recorder that is in-
stalled. 

 

The results are displayed in two graphs: the top one shows the results for C1 errors/PI errors 

(for CD's and DVD's respectively), while the bottom one shows the results for C2 errors/PI 
failures (for CD's and DVD's respectively). In the top graph, the vertical scales on the left 
show the number of C1 errors/PI errors and the vertical scales on the right show the 
write/read speed. In the bottom graph, the vertical scales on the left show the number of C2 

errors/PI failures and the vertical scales on the right show the jitter value. The horizontal 
scale in both graphs shows the disc capacity, in MB for CD's and in GB for DVD's. 
 

 
If you want to omit a protected area from the bottom graph, enable the Use 
background to show error limits check box in the options under the Disc Qual-
ity navigation entry. 

 

In addition, both test results and data on the test in progress are shown in the Disc info area 
and in a number of other display panels to the right of the graph. In the PI errors, PI Fail-
ures, and Jitter areas under the graph, information on the disc quality is displayed in real-
time while the test is run. The number of PO failures is also shown here. 
 

 
If the Include test data check box has been enabled in the options under the 
Transfer Rate navigation entry, an additional display panel showing information 
on the recorder and the firmware used to burn the disc in the drive is shown 
above the graph. 
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Disc Quality tab 

You can define preferences for the test in the Settings area to the right of the graph. In addi-
tion, the necessary basic settings in the options under the Disc Quality navigation entry 
must be met. 
The following setting options are available on the tab: 

Menu 
Speed 

Defines the speed at which the test is run. The available entries in the 
drop-down menu vary depending on the disc in the drive. 

Button 

 

Refreshes the entries in the drop-down menu of available speeds. 
If there are several drives connected to your computer, we recommend 
that you refresh the data once you have chosen the optical drive for 
the test. 

Input field 
Start 

Defines the start value from which the test should run. This value can 
be manually entered. 
Select the value 0000MB to start the test from the beginning of the 
disc. 

Input field 
End 

Defines the end value up to which the test should run. This value can 
be manually entered. 
Nero DiscSpeed suggests a value for the disc in the drive. For a 
burned disc, this value may deviate from the maximum capacity, since 
the data may either not fill up or exceed the maximum capacity. 
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Check box 
Quick Scan 

If this box is checked, the quick scan will be run as per the settings you 
defined in the options under the Disc Quality navigation entry. 
If this box is not checked, the entire disc will be scanned. 

Check box 
Show C1/PIE 

If this box is checked, the C1 errors/PI errors will be shown. 
If this box is not checked, this information will be hidden. 

Check box 
Show C2/PIF 

If this box is checked, the C2 errors/PI failures will be shown. 
If this box is not checked, this information will be hidden. 

Check box 
Show Jitter 

If this box is checked, the jitter will be shown. If this box is not checked, 
this information will be hidden. 
Not all recorders can measure jitter values. Even if this box is checked, 
the jitter will not be shown if the recorder in question cannot measure 
the values. 

Check box 
Show read speed 

If this check box is enabled, the read speed is displayed in the top 
graph. 
The curve is displayed in red by default. You can change this color 
according to your requirements in the options under the Disc quality 
navigation entry. 

Check box 
Show write 

speed 

If this check box is enabled, the write speed is displayed in the top 
graph. 
The curve is displayed in white by default. You can change this color 
according to your requirements in the options under the Disc quality 
navigation entry. 
If the Include test data check box has been enabled in the options 
under the Transfer Rate navigation entry, the write speed will have 
been recorded on the disc during the burn process and will be availa-
ble for further tests on the disc. If this box was not checked during 
burning, the write speed cannot be displayed as the information will not 
have been saved on the disc. 

Button 
Advanced 

Opens the Disc Quality Test: Advanced Options dialog box. 

 

The Disc info area shows general information on the disc in the drive. The following display 
panels are available: 

Type Shows the disc type of the disc in the drive. 

ID Shows the media code of the disc. 

Date Shows the date when the disc was created/burned. If an image file was burned to 
the disc, this display panel shows the date on which the image file was created. 
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Label Shows the disc label of the disc in the drive. 
If you do not want to show the disc label, disable the Show disc label box in the 
options under the Disc Quality navigation entry. 

 

There is more information available in the following display panels: 

Quality score A percentage is calculated based on the results of the test. A quality 
index of 100% is perfect, i.e. there were no errors. 

Progress Shows the progress of the test, i.e. the percentage of the disc already 
scanned. 

Position Continuously indicates the current position of the read head on the 
disc. 

Speed Shows the scanning speed. 
 

The C1 Errors or PI Errors area shows information onC1 or PI errors found. If a CD has 
been inserted in the optical drive, C1 errors are shown in this area. If a DVD has been in-
serted in the optical drive, PI errors are displayed in this area. 

The following display panels are available: 

Average Shows the average number of C1 or PI errors found. 

Maximum Shows the maximum number of C1 or PI errors. 

Total Shows the total number of C1 or PI errors found. 
 

The C2 Errors or PI Failures area shows information on C2 errors or PI failures found. If a 
CD has been inserted in the optical drive, C2 errors are shown in this area. If a DVD has 
been inserted in the optical drive, PI failures are shown in this area.  

The following display panels are available: 

Average Shows the average number of C2 errors or PI failures found. 

Maximum Shows the maximum number of C2 errors or PI failures. 

Total Shows the total number of C2 errors or PI failures found. 
 

The Jitter area shows information on the jitter. Not all recorders can measure jitter values. 
The display panels remain blank if the recorder in question cannot measure the values. The 
following display panels are available: 

Average Shows the average jitter value. 

Maximum Shows the maximum jitter value. 
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The number of PO failures is shown in the PO Failures display panel. These are the gravest 
errors that can be found on a DVD. PO failures are normally an indication of there being 
unreadable data on the disc. 

See also 
  Disc Quality Entry → 62 
  Transfer Rate Navigation Entry → 56 
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8 ScanDisc 
  

8.1 Running the ScanDisc Test 
The ScanDisc test can be run in two versions: as a read test and as a C1/C2 – PI/PO test. 

The following requirement must be fulfilled: 

 ► The ScanDisc tab is selected in the main screen. 
To start the ScanDisc test, proceed as follows:  

 1. If there are several optical drives available, select the one you want in the drop-down 
menu. 

 2. Insert a disc into the optical drive. 

 3. Select the speed with which you want to run the test from the Speed drop-down menu. 

 4. If you want to run the test as a read test, select the Read test option button. 
If you want to run the test as a C1/C2 - PI/PO test, select the C1/C2 - PI/PO test option 
button. 

 5. Click the Start button. 
 The test is run. You can follow the test processes in the areas under and next to the 

graph. You can cancel the running test at any time by clicking the Stop button. 
  You can now see the results of the test in the graphs and the relevant displays and 

save them. 

 

See also 
  Saving Test Data → 47 
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8.2 ScanDisc Tab 
The Scan Disc test is available on the Scan Disc tab, where the result is also displayed. It 
can be run in two versions: as a read test and as a C1/C2 – PI/PO test. 
You can use the Read test to test optical drives and/or burned discs. The test checks 
whether burning was successful and whether all areas can be read. 
 

 
If you want to test burned discs, we recommend that you set the test speed to 
maximum. You will then be testing the disc under worst-case conditions. 

 

The C1/C2 - PI/PO test lets you check the quality of the disc with respect to completeness of 
the sectors. It must be noted that this test is different from the disc quality test, even if the 
latter is similar to the C1/C2 - PI/PO test. The results from the C1/C2 - PI/PO test are dis-
played differently in the graph. Instead of the number of errors, the status of the sectors is 
shown. 
The test results of both versions are displayed both in a graph and in detail in the display 
panel below the graph. In addition, both the test results and data on the test in progress are 
shown in the Disc info, Surface scan, and Position areas to the right of the graph. 

 
ScanDisc tab 
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You can define preferences for the test in the Settings area to the right of the graph. The 
following setting options are available: 

Menu 
Speed 

Defines the speed at which the test is run. The available entries in the 
drop-down menu vary depending on the disc in the drive. 

Option button 
Read test 

Enables the Read test. 

Option button 
C1/C2 - PI/PO 

Test 

Enables the C1/C2 – PI/PO test. 

 

The graph shows all sectors on the disc in one chart, with each sector being plotted with a 
small square. Each square, i.e. each sector, is displayed in a different color depending on its 
status. The Surface scan area shows the respective percentage of sectors in the following 
three categories: Good, Damaged, and Bad in real time while the test is running. The 
following colors, i.e. status indicators, are available: 

Green Readable sectors with no errors. 

Yellow Damaged sectors that can still be read using the recorder's internal error correc-
tion feature. 

Red Damaged sectors that cannot be corrected and are consequently unreadable. 
 

The Disc info area shows general information on the disc in the drive. The following display 
panels are available: 

Type Shows the disc type of the disc in the drive. 

ID Shows the media code of the disc. 

Date Shows the date when the disc was created/burned. If an image file was burned to 
the disc, this display panel shows the date on which the image file was created. 

Label Shows the disc label of the disc in the drive. 
If you do not want to show the disc label, disable the Show disc label box in the 
options under the Disc Quality navigation entry. 

 

 

 
If the Include test data check box has been enabled in the options under the 
Transfer Rate navigation entry, an additional display panel showing information 
on the recorder and the firmware used to burn the disc in the drive is shown 
above the graph. 
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The following display panels are available in the Position area while the test is running: 

Progress Shows the progress of the test, i.e. the percentage of the disc already 
scanned. 

Position Continuously indicates the current position of the read head on the disc. 

Speed Shows the scanning speed. 
 

The following information is available in the columns in the display panel: 

File Lists the names of the files on the disc in the drive. 

Position Shows the respective position of the file on the disc. 

Length Shows the length of the individual files. 

Quality Specifies the quality of the files. This score is calculated from the number of 
errors found. 

PIE Specifies the number of PI errors found. 

Only available for the C1/C2 – P1/PO test. 

PIF Specifies the number of PI failures found. 
Only available for the C1/C2 – P1/PO test. 

POE Specifies the number of PO errors found. 

Only available for the C1/C2 – P1/PO test. 

POF Specifies the number of PO failures found. 

Only available for the C1/C2 – P1/PO test. 

Jitter Specifies the jitter values. 

Only available for the C1/C2 – P1/PO test. Not all recorders can measure jitter 
values. This column is omitted if the recorder in question cannot measure the 
values. 

 

See also 
  Transfer Rate Navigation Entry → 56 
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9 Additional Test - Advanced DAE Quality 
The Advanced DAE Quality Test is different from the standard DAE Quality test. With a 
special test disc, the advanced test identifies problems that your optical drive may have 
when reading an Audio CD. 
You can run the test in two steps, depending on whether you first want to create a test CD 
and then test it or you already have a suitable test disc with which you can start the test di-
rectly. 
In addition, the Error test lets you determine the capabilities of an optical drive to prevent 
errors when creating a copy. 

See also 
  Creating a Test Disc → 35 
  Running the Advanced DAE Quality Test → 37 
  

9.1 Creating a Test Disc 
To create a test disc, proceed as follows: 

 1. Insert an empty CD into the recorder. 

 2. Click Extra > Advanced DAE Quality Test > Create Test CD. 
 The Nero DiscSpeed DAE Test Disc window opens. 

 3. Make the settings you want in the top part of the window. 

 4. Click the Start button. 
 The burn process starts. You can monitor the progress of the burn process in the 

Write position and Disc information areas, as well as in the display area under-
neath. 

  You have created a test disc and can now use it to run the advanced DAE quality test. 

See also 
  Running the Advanced DAE Quality Test → 37 
  

9.2 DAE Test Disc Window 
You can create a test disc in the Nero DiscSpeed - DAE Test Disc window. 
You can define preferences for the burn process in the top area of the window. Information 
on the write process in progress and on the disc in the drive is displayed in the Write posi-
tion and Disc information areas as well as in the display area at the bottom of the window. 
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Nero DiscSpeed Window - DAE Test Disc 

 

The following setting options are available: 

Menu 
Write speed 

Defines the speed at which the disc is burned. We recommend that 
you choose a speed of 16x or less when burning an audio CD. 

Input field 
Test capacity 

Shows the disc capacity in MSF (minutes/seconds/frames). 

Check box 
Simulate 

If this check box is selected, Nero DiscSpeed simulates the burn 
process rather than writing data to the recordable disc.  
This check box is selected by default. 

Check box 
RAW mode 

If this box is checked, the disc will be burned in RAW mode. 

The following information on the write process in progress is displayed in the Write position 
area: 

Position Continuously indicates the current position of the read head on the 
disc. 
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Relative Always indicates the percentage of the disc that has already been 
written. 

 Indicates the burn progress. 
 

The following information on the disc in the drive is displayed in the Disc information area 
and in the display area: 

Capacity Shows the disc capacity both in MSF (minutes/seconds/frames) and in MB. 
Maximum specifies the maximum volume of data that can be written to the 
disc with the help of additional capacity achieved through overburning. 
Extra - Shows the difference between normal capacity and maximum ca-
pacity. 

Manufacturer Shows the manufacturer's name. 

Dye type Shows the dye type used.  

Disc type Shows the disc type of the disc in the drive. 
 
  

9.3 Running the Advanced DAE Quality Test 
The following requirement must be fulfilled: 

 ► You have already created a test disc. 
To run the test, proceed as follows:  

 1. If there are several optical drives available, select the one you want in the drop-down 
menu. 

 2. Insert the special test disc that you previously created into the optical drive. 

 3. Click Extra > Advanced DAE Quality Test > Run Test on the menu bar. 
 The Nero DiscSpeed - Advanced DAE Quality Test window opens. 

 4. Make the settings you want in the Advanced features area. 

 5. Click the Start button. 
 The test is run. You can cancel a running test at any time by clicking the Stop button. 

  You can now see the results of the test in the Test results and On-the-fly copying 
areas, as well as their detailed information in the display area, and save them. 

See also 
  Saving Test Data → 47 
  Creating a Test Disc → 35 
  



Additional Test - Advanced DAE Quality 

 Nero DiscSpeed 38 

9.4 Nero DiscSpeed window - Advanced DAE Quality Test 
In the Nero DiscSpeed - Advanced DAE Quality Test window, you can run the advanced 
DAE quality test, and the result is also shown there. 
The results are displayed in the Test results and On-the-fly copying areas, as well as in 
detail in the display area. A progress bar at the bottom of the window indicates the status of 
the test while it is running. 
In the On-the-fly copying area, the test determines whether an audio CD can be copied 
without causing errors at various speeds between 1x and 16x, i.e. indicates if the optical 
drive is suitable for use on-the-fly in combination with a recorder for backing up audio discs. 

The results of two tests are displayed in the Test results area: the Sequential read test and 
the Random read test. The sequential read test simulates the digital extraction of audio files 
(DAE) under ideal conditions and then runs a harmonic read test. This test helps you to iden-
tify errors on the disc. There are two different types of error. 
A search for data errors returns audio samples that were not read correctly, based on a 
comparison of the read bytes with the known data from the test disc. Minor data errors can 
be corrected using the drive's error correction feature. The most common cause of data er-
rors is poor-quality discs. Avoid data errors by using high-quality discs and/or reducing the 
drive speed. 
Synchronization errors occur when, instead of reading the required audio sectors, an optical 
drive reads the adjacent sectors. Nero DiscSpeed uses special data on the test disc to check 
if the correct sectors are being read. Synchronization errors can result in samples being lost 
or repeated. These errors can be audible. 

 
Nero DiscSpeed window - Advanced DAE Quality Test 
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You can define preferences for the optical drive test in the Advanced features area. Optical 
drives start from different positions when reading audio sectors. There is also no standar-
dized start position for the write process of recorders - there is usually a gap of a few hun-
dred samples. The following check boxes are available: 

Read Leadin If this check box is enabled, the capability of the optical drive of reading 
the leadin is tested. To create perfect copies, an optical drive should 
begin reading data before the actual start position. 

Read Leadout If this check box is enabled, the capability of the optical drive of reading 
the leadout is tested. To create perfect copies, an optical drive should 
read data from the leadout. 

Read CD Text If this check box is enabled, the capability of the drive of reproducing 
CD Text is tested. 

Read Subchannel 
Data 

If this check box is enabled, the subchannel data is read during the 
test. 
Subchannel data contains information such as index markers. An opti-
cal drive must be able to reproduce this data if it is to create perfect 
audio copies. 

 

The following information is available in the Test results area: 

Average Speed Calculates and shows the average speed of the completed test. 

Data Errors Lists the data errors found.  

Sync Errors Shows the number of synchronization errors found. 
Synchronization errors occur when data is correct but has been moved 
by one or more sectors. 

Quality score A percentage is calculated based on the results of the test. A quality 
index of 100% is perfect, i.e. there were no errors. 

   

9.5 Error Test 
The Error test determines the capability of a optical drive to prevent errors when creating a 
copy. The test is run in two steps: The Create Image feature first creates an image file of 
your test disc and saves it on the hard drive. After this, the Run Test feature reads the data 
on your test disc in order to compare it with the image file. 
To run this test you need a standard test disc of the type A-BEX (TCD-714R, TCD-721R, or 
TCD-726). All A-BEX discs contain the same data (audio data). The reading surface of the 
various A-BEX discs contains a series of intentional defects of varying severity. 
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Instead of using an A-BEX disc, you can also run a limited version of the test by using a DAE 
test disc that you have previously created. It is not necessary to create an image file in this 
case, since Nero DiscSpeed is familiar with the contents of the comparison disc. 

See also 
  Creating a Test Disc → 35 
  Create Image → 40 
  

9.5.1 Create Image 
The Create Image feature lets you extract data from an A-BEX disc in order to create an 
error-free image file on the hard drive - provided the optical drive can create the file from the 
data provided. 
To create an image file of the test disc, proceed as follows: 

 1. If there are several optical drives available, select the one you want in the drop-down 
menu. 

 2. Insert an A-BEX disc in the optical drive. 

 3. Click Extra > Advanced DAE-Quality Test > Error Tests > Create Image. 
 The Nero DiscSpeed - Advanced DAE - Create Image window opens. 

 4. Click the Start button. 
 The image file of the test disc is created. You can follow the progress of the write 

process with the progress bar, and can cancel the process at any time by clicking the 
Stop button. 

  A dialog box opens that informs you whether the image file has been successfully 
created. You have created an image file of the test disc and can now use it to proceed 
with the second part of the error test, Run Test. 

See also 
  Running the Test with an A-BEX Test Disc → 40 
  

9.5.2 Running the Test with an A-BEX Test Disc 
The Run Test feature reads the data on an A-BEX disc and compares it to an image file of 
the same disc. This test ensures that the copy created is perfect. 

The following requirement must be fulfilled: 

 ► The image file of the test disc must be saved on the hard drive. 
To compare the test disc to the associated image file on the hard drive, proceed as follows:  

 1. If there are several optical drives available, select the one you want in the drop-down 
menu. 

 2. Insert an A-BEX disc whose image file is already on the hard drive into the optical drive. 

 3. Click Extra > Advanced DAE Quality Test > Error Test > Run Test. 
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 The Nero DiscSpeed - Advanced DAE Error Correction Test window opens. 

 4. Some optical drives show C2 errors in reverse order. If you want to correct this, enable the 
Reverse C2 check box. 

 5. Click the Start button. 
 The test is run. The graphs and the areas underneath indicate the progress. You can 

cancel a running test at any time by clicking the Stop button. 
  You can now see the results of the test in the graphs and the relevant displays and 

save them. 

See also 
  Saving Test Data → 47 
  Create Image → 40 
  

9.5.3 Running the Test with a DAE Test Disc 
Instead of using an A-BEX disc, you can also run a limited version of the Error test by using 

a DAE test disc that you have previously created. In this case it is not necessary to create an 
image file, since Nero DiscSpeed already knows the content of the comparison disc. 
To run the test, proceed as follows:  

 1. If there are several optical drives available, select the one you want in the drop-down 
menu. 

 2. Insert a DAE disc in the optical drive. 

 3. Click Extra > Advanced DAE Quality Test > Run Test. 
 The Nero DiscSpeed - Advanced DAE Error Correction Test window opens. 

 4. Some optical drives show C2 errors in reverse order. If you want to correct this, enable the 
Reverse C2 check box. 

 5. Click the Start button. 
 The test is run. You can cancel a running test at any time by clicking the Stop button. 

  You can now see the results of the test in the graphs and the relevant displays and 
save them. 

See also 
  Saving Test Data → 47 
  Creating a Test Disc → 35 
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9.5.4 Advanced DAE Error Correction Test Window 
The Error test is run in the Nero DiscSpeed - Advanced DAE Error Correction Test win-
dow. 
The results are displayed in the C2 errors and Compare errors graphs, as well as in the 
display areas underneath, while the test is still in progress. The top graph shows C2 errors 
found on the disc. The bottom graph compares the errors found when Nero DiscSpeed com-
pares the data on the disc with the data from the image file. 

 
Nero DiscSpeed window- Advanced DAE Error Correction Test 

 

The following fields are available in the areas below the graphs: 

Position Continuously indicates the current position of the read head on the disc 
over the course of the write process. 

Elapsed Specifies in minutes and seconds the time elapsed since the write 
process started. 

C2 accuracy The C2 accuracy of the optical drive is determined based on the results 
of the test. 
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Quality score A percentage is calculated based on the results of the test. A quality 
index of 100% is perfect, i.e. there were no errors. 

C2 errors Shows the number of C2 errors found. 

C2 missed Shows the number of C2 errors missed. 

Compare errors Shows the number of compare errors found. 
Compare errors occur when the audio data read out does not match 
the compare data from the image file. 

Sync Errors Shows the number of synchronization errors found. 
Synchronization errors occur when data is correct but has been moved 
by one or more sectors. 
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10 Additional Test - Overburning 
 

 
Not all recorders support overburning. 

Note that overburning can damage an optical drive. To prevent damage to the 
optical drive, you should only use this feature with suitable discs. 

Note that a disc whose leadout has been written to no longer conforms to the 
standard specification for CDs, and therefore may not be detected by some read-
ers. 

Overburning is the process of writing data past the official capacity of the disc in the CD's 
leadout area. The actual purpose of the leadout area is to define where the disc ends. By 
filling part of the leadout with data instead of zeros it is possible to increase the disc's capaci-
ty. Usually it is possible to overwrite the 90 seconds of the leadout without any difficulty. 
Nonetheless there is a high probability that the data will become unreadable since the area 
was originally intended for storing only zeros and is at the outer edge of the disc. This part of 
the disc is more likely to become damaged or soiled. 
Overburning is also possible, although not advisable, with DVD's. The outer edge of DVD's is 
more susceptible to errors. Furthermore only a small number of DVD recorders support this 
feature. 
The Overburning Test feature lets you run a simulation of the overburn process and test 
whether or not the recorder is suitable for this process. Nero DiscSpeed also checks how 
much data can be written to the disc being used. 
 

 
If you want to test the overburn capability of a disc and your recorder in a real 
burn process, enable the Overburn CD or Overburn DVD (depending on the 
disc type) check box under the Transfer Rate navigation entry, in the Nero 
DiscSpeed – Options window. 

After this, start the Create data disc standard test. 

See also 
  Transfer Rate Navigation Entry → 56 
  Create Data Disc (Classic Version) → 18 
  

10.1 Running the Overburning Test 
To run the overburning test as a simulation, proceed as follows:  

 1. If there are several optical drives available, select the one you want in the drop-down 
menu. 

 2. Insert a blank disc in the optical drive. 

 3. Click Extra > Overburning Test. 
 The Nero DiscSpeed - Overburning Test window opens. 
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 4. If you want to simulate the burn process in RAW mode, enable the RAW mode check box. 

 5. Choose the volume of data that you want to write to the disc or let Nero DiscSpeed 
determine the official capacity. 

 6. Click the Start button. 
 The simulation is started. You can follow the progress of the burn process in the Write 

position and Disc information areas, as well as in the display area underneath. You 
can cancel a running test at any time by clicking the Stop button. 

 A dialog box specifying the maximum detected capacity opens. 

 7. If you want to add the detected value to the internal overburning database, click the Yes 
button. 
 If a disc of the same type is inserted again, Nero DiscSpeed will detect it in this way, 

and the results stored in the database can be displayed in the display area. 

 8. If you want to discard the detected value, click the No button. 

  You have run the overburning test. 
  

10.2 Nero DiscSpeed - Overburning Test window 
The overburn process simulation is run in the Nero DiscSpeed - Overburning Test window. 
The results are displayed in the same window, in the Write position and Disc information 
areas, as well as in the display area at the bottom of the window. 

 
Nero DiscSpeed - Overburning Test window 
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You can define preferences for the test in the top section of the window. The following set-
ting options are available: 

Menu 
Write speed 

Defines the speed at which burning of the disc is simulated. 
We recommend that you choose a speed of 16x or less when burning 
an audio CD. 

Input field 
Test capacity 

Shows the disc capacity in MSF (minutes/seconds/frames). 

Check box 
Simulate 

If this check box is selected, Nero DiscSpeed simulates the burn 
process rather than writing data to the recordable disc.  
This check box is selected by default. 

Check box 
RAW mode 

If this box is checked, the burn process will be simulated in RAW 
mode. 

 

The following information on the burn process simulation in progress is displayed in the 
Write position area: 

Position Continuously indicates the current position of the read head on the 
disc. 

Relative Always indicates the percentage of the disc that has already been writ-
ten. 

 Shows the progress of the simulated burn process: 
Green – Data written within the disc's normal capacity. 
Yellow – Data written past the disc's normal capacity. 
Dark green – Buffer status. 
Blue – Standard, official disc capacity. 
Red – Current position of the read head on the disc. 

 

The following information on the disc that is inserted in the drive is displayed in the Disc 
information area and in the display area 

Capacity Shows the disc capacity both in MSF (minutes/seconds/frames) and in MB. 
Maximum specifies the maximum volume of data that can be written to the 
disc with the help of additional capacity achieved through overburning. 
Extra - Shows the difference between normal capacity and maximum ca-
pacity. 

Manufacturer Shows the manufacturer's name. 

Dye type Shows the dye type used.  

Disc type Shows the disc type of the disc in the drive. 
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11 Save and Load Test Data 
  

11.1 Saving Test Data 
The Save Results menu item lets you save the full set of results from a test on the hard 
drive. 
 

 
Nero DiscSpeed offers different storage formats: 
Only test data saved as binary files with the *.dat extension can be loaded again. 
Use this format if you want to open the test data in Nero DiscSpeed and/or open 
and compare the test data in the Nero DiscSpeed database. 
An *.html file that you can open with any Web browser saves the results as a 
graph. In the Options window, under the Save navigation entry, you can define 
how much data will be saved in the file. If the Include status check box is 
enabled, the diagram and all other test results are saved; if it is cleared, only the 
graph is saved. 
A *.csv file saves the test results in a pure text file that you can open with any text 
editor. 

The following requirements have to be fulfilled: 

 ► The test you want has already been run. 
 ► The results are displayed on the corresponding tab in the main screen. 
To save the test results, proceed as follows: 

 1. Click File > Save Results and choose your preferred storage format. 
 The Save As window appears. 

 2. Enter a file name in the File name input field if necessary. 

 3. Click the Save button. 

  You have saved the test file. 

See also 
  Save Navigation Entry → 59 
  Loading Test Data → 47 
  

11.2 Loading Test Data 
The Load Single File menu item lets you load saved test data, while the Database menu 
item lets you load several files at once in order to compare test results and/or the efficiency 
of optical drives. 

 
Only test data saved as binary files with the *.dat extension can be loaded again. 

 

 
In order to make effective use of the database, i.e. to get comparable results, you 
should use the same disc for the different tests in all optical drives. 
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To load test results, proceed as follows: 

 1. If you want to open a single saved test file: 

 1. Click File > Load Results > Load Single File. 
  The Open window appears. 

 2. Select the file you want and click the Open button. 
  The chosen file is opened in the main screen on the Benchmark tab and the test data 

is displayed. 

 2. If you want to load several files at once for comparison:  

 1. Click File > Load Results > Database in the menu bar. 
  The Nero DiscSpeed - Database window opens. 

 2. Click the Add Results button. 
  The Insert Files dialog box opens. 

 3. Select the files you want and click the Open button. 
  The test files are imported and displayed in the Nero DiscSpeed – Database window. 

 4. Check the boxes beside the files you want to compare. 
 5. In the lower part of the window, select the option button for the test type for which you 

want to compare data. 
  The results of the chosen test are displayed for the chosen test files. 

 6. Click the Graph button. 
  The Nero DiscSpeed Test Results window is opened and shows a graph of the se-

lected test results. The results for each test file are displayed in a different color (the 
Legend area shows which graph corresponds to which test). 

 
Nero DiscSpeed - Test Results window 

  You have loaded your chosen test results. 
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12 Erasing a Disc 
The Erase Disc feature lets you erase data from rewritable discs. This operation is run in the 
Nero DiscSpeed - Erase window. As a general rule, there are two erase methods available: 
Quick erasing does not remove the data physically from the disc, but instead only makes it 
inaccessible by erasing the references to existing content. The data can be restored! 
Full erasing removes the data from the disc by overwriting it with zeroes. The contents can-
not be restored with conventional methods. Repeated full erasing increases the probability 
that third parties will not be able to reconstruct the contents.  
To erase a rewritable disc, proceed as follows: 

 1. If there are several optical drives available, select the one you want in the drop-down 
menu. 

 2. Insert the disc that you want to erase into the optical drive. 

 3. Click Extra > Erase Disc. 
 The Nero DiscSpeed - Erase window opens. 

 
Nero DiscSpeed - Erase window 

 

 4. Select the option button for the erase method you want. 

 5. Click the Erase button. 
 The erase procedure starts. You can cancel the erase process in progress at any time 

by clicking the Exit button. 
  You can track the progress of the erase process with the progress bar. 
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13 Bit Setting 
The Bitsetting feature lets you change the bit settings or Book type of a selected DVD re-
corder in the Nero DiscSpeed - Bit Setting window (provided the recorder in question sup-
ports this feature). 

The book type information is what an optical drive uses to detect the inserted disc type. By 
changing the book type, you can fool the player into believing that the inserted DVD is a 
pressed disc and not a burned disc. 
Not all DVD recorders can modify the book type. What's more, the book type can only be 
changed for "plus" media (e.g. +R). With other media types, the book type is already on the 
disc before the burn process. 
  

13.1 Changing the Bit Setting 
To edit the bit settings for a DVD recorder, proceed as follows:  

 1. If there are several optical drives available, select the one you want in the drop-down 
menu. 

 2. Click Extra > Bitsetting. 
 The Nero DiscSpeed - Bit Setting window opens. The Drive settings area shows 

the disc types, as well as the respective book types. 

 3. Change a book type in the corresponding New setting drop-down menu and click the Set 
button. 

 4. If you want to retain the modified book type setting as the default setting for the optical 
drive, enable the Set as default check box. 

 5. Click the Refresh button. 
 The display in the window will be refreshed. The Drive settings area shows the disc 

types and the modified book types as a selection under Book Type. 

 6. Click the Close button. 

  You have changed the bit settings for a DVD recorder. 
  

13.2 Nero DiscSpeed - Bit Setting Window 
Bit settings and book type modifications are carried out in the Nero DiscSpeed - Bit Setting 
window. 
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Nero DiscSpeed - Bit Setting window 

The Drive settings area shows the defined book type, as well as all the changes that can be 
made. The following information is displayed: 

Disc type Shows the disc type of the disc in the drive. 

Book type Shows the book type of the disc in the drive. 
 

The following setting options are available: 

Menu 
New setting 

Shows which new settings can be selected for the book type. 
Media types not supported by the chosen optical drive are grayed out. 

Button 
Set 

Accepts the changes made. 

Check box 
Set as default 

If this check box is enabled, the chosen changes will be retained as the 
default settings for the optical drive even after the computer is restarted.  
This check box will be grayed out if the optical drive does not support 
this feature. 

 

The Disc settings area shows the disc type currently selected and the selected book type. 
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14 Nero DiscSpeed Options Window 
The Nero DiscSpeed - Options window provides various options for customizing the ap-
pearance of the Nero DiscSpeed interface and for configuring settings according to your 
requirements. 

The window can be opened using the  button. It comprises a navigation tree and various 
setting options. Different input areas will be displayed depending on the entry selected in the 
navigation tree. 
  

14.1 User Interface Navigation Entry 
The User Interface navigation entry offers setting options in the Language, Disc info 
(DVD), Priority, and Colors areas. 

 
Nero DiscSpeed - Options - User Interface navigation entry 

The following setting options are available in the Language area: 

Menu 
Language 

Specifies the language to be used in the program interface. 
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In the Disc info (DVD) area, you can select which information is displayed on the Bench-
mark tab on the main screen. This setting will only be available if there is a DVD in the opti-
cal drive. The following setting options are available: 

Option button 
Disc type 

Shows the Disc type of the DVD. 

Option button 
Book Type 

Shows the book type of the DVD. 

 

The following setting options are available in the Priority area: 

Menu 
Priority 

Selects the priority of Nero DiscSpeed. Each process in Windows is 
run with a defined priority. This priority defines how efficiently Nero 
DiscSpeed can access the computer's resources, e.g. memory. 
The following priority levels are available for selection: Low, Normal, 
High, and Realtime. 
Set the priority to High to prevent your tests from being interfered with 
by other processes running concurrently on the computer. 

 

In the Colors area, you can define the colors for the Benchmark tab in the main screen. 
The following setting options are available: 

Menu 
Theme 

Selects the desired theme. In addition to predefined themes, you can 
also set colors with the costum entry. To manually edit a color, click 
the colored tile and select the color you want in the dialog box that 
appears. 

Button 
Background 1 

Changes the basic color in the background of the graph area. 

Button 
Background 2 

Changes the basic color for shading in the background of the graph 
area. 
Only works when the Background 2 check box is enabled. Otherwise, 
the background of the graph area is displayed in one single color. 

Button 
Grid (primary) 

Changes the colors for the coarse grid in the graph area. 
Only works when at least one of the following check boxes is enabled: 
Show horizontal grid and/or Show vertical grid. 

Button 
Grid (secondary) 

Changes the color for the fine grid in the graph area. 
Only works when at least one of the following check boxes is enabled: 
Show horizontal grid and/or Show vertical grid. 

Button 
Speed 

Changes the color for the graph curve that represents speed (write or 

read speed, depending on the test). 
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Button 
RPM 

Changes the color for the graph curve that represents the rotational 
speed of the disc. 

Button 
Buffer level 

Changes the color for the Buffer level curve. 

Button 
CPU usage 

Changes the color for the CPU usage curve. 

Check box 
Show horizontal 

grid 

Shows the horizontal grid lines in the graph area or hides them. This 
box is checked by default. 

Check box 
Show vertical 

grid 

Shows the vertical grid lines in the graph area or hides them. This box 
is checked by default. 

 
  

14.2 Standard Tests Navigation Entry 
The Standard Tests navigation entry offers setting options in the Selected tests, Speed, 
and Spin-up time areas. 

 
Nero DiscSpeed - Options - Standard Tests navigation entry 
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In the Selected tests area, you can define the standard tests that are run automatically if 
you click the Start button on the main screen or the menu item Run Test > Selected. These 
tests are run on the Benchmark tab. All tests are activated by default. 

The following setting options are available: 

Check box 
Transfer rate 

Adds the test to the standard test series. The Transfer rate test 
measures the read speed of data, i.e. the speed at which data is 
read from a disc. If the disc inserted is blank, the test measures 
the write speed. 

Check box 
DAE quality 

Adds the test to the standard test series. The DAE quality test 
comprises two partial measurements. 

Check box 
Access/Seek Times 

Adds the test to the standard test series. The Access/seek times 
test measures the access or seek times of optical drives for discs 
inserted in the drive in three partial measurements. 

Check box 
CPU usage 

Adds the test to the standard test series. The CPU usage test 
measures the percentage utilization of the CPU (central 
processing unit) at various speeds (1x, 2x, 4x, and 8x). 

Check box 
Burst Rate 

Adds the test to the standard test series. The Burst rate test 
measures the maximum possible transmission rate from the opti-
cal drive to the computer. 

Check box 
Spin up/down 

Adds the test to the standard test series. The Spin down test 
measures how long it takes an optical drive to stop, while the Spin 
up test measures how long it takes before the optical drive can 
read data again after stopping. 

Check box 
Load/Eject 

Adds the test to the standard test series. The Load/eject test 
measures the time that an optical drive needs to load, detect, and 
eject a disc. 

Check box 
Extra read tests 

Adds the test to the standard test series. The Extra read tests test 
series consists of three tests. One or more sectors on the disc are 
read with defined test samples. 

Check box 
Create data disc 

Adds the test to the standard test series. The Create data disc 
test is available in its classic version on the Benchmark tab and 
as an advanced version on the Create Disc tab. You can use the 
classic test to analyze the write speed and the rotational speed. 

You can use the advanced test to also measure the buffer level 

and the CPU usage caused by the optical drive. 
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Check box 
Verify data 

Checks the data that was written on the disc during the Create 
data disc test. 

 

In the Speed area, you can define the read speed for the Transfer rate test and the write 

speed for the Create data disc test. Maximum speed is enabled by default; this speed is also 
recommended for testing the optical drive and/or the discs under worst-case conditions. The 
following setting options are available: 

Option button 
Maximum 

Selects the maximum speed that an optical drive can achieve. 

Option button 
Current 

Selects the current speed of the optical drive. This speed is not influ-
enced, and can be affected by other system settings, e.g. other software 
or the firmware settings. 

Option button 
Selected 

Selects the speed manually. Enter the desired value in the input field. 

 

The following setting option is available in the Spin-up time area: 

Spin-up time Defines the spin-up time. 
In order to stabilize the disc and the optical drive, Nero DiscSpeed starts 
spinning the disc before the actual test starts. The default setting here is 
10 seconds. 

 

See also 
  Transfer rate → 14 
  DAE Quality → 16 
  Access/Seek Times → 16 
  CPU Usage → 17 
  Burst Rate → 17 
  Spin Up/Down → 17 
  Load/Eject → 17 
  

14.3 Transfer Rate Navigation Entry 
The Transfer Rate navigation entry offers setting options in the Graph and Write options 
areas specifically for the Transfer rate test. 
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Nero DiscSpeed - Options - Transfer Rate navigation entry 

You can define the settings for the graph in the Graph area. The following setting options 
are available: 

Slider 
Test length 

Defines the accuracy of the transfer rate test. 
The higher the accuracy, the more detailed the graph is. 
However, higher accuracy results in a longer test duration. 

Check box 
Show RPM 

Shows the rotational speed in the graph. 

Menu 
Maximum speed CD/DVD 

Defines the maximum value shown on the vertical scale of 
the graph on the Create Disc tab if a CD/DVD is inserted 
into the optical drive. 
To prevent parts of the curve from extending past the edge 
of the graph area, we recommend that you choose a value 
slightly above the maximum read speed of the optical drive. 

Check box 
Show minimum/maximum 

Shows the minimum and maximum speed values recorded 
during the transfer rate test. 
In a normal curve, the lowest speed is the start speed while 
the highest speed is the end speed. In an uneven curve, 
the lowest recorded speed is displayed as the minimum 
value while the highest recorded speed is displayed as the 
maximum value. 
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Check box 
Read test 

Shows the read test curve in either high or low resolution. 

Check box 
Write test 

Shows the write test curve in either high or low resolution. 

 

The following setting options are available in the Write options area: 

Area 
Write mode 

Selects the SAO (Session-At-Once) or TAO (Track-At-Once) write 
mode for discs. 
You can also select the Overburn CD and Overburn DVD check 
boxes in Session-At Once mode. Enter the exact data quantity in the 
corresponding input fields. 

Area 
Disc type 

Enables burning simulation for either data or audio discs. 

Check box 
Buffer underrun 

protection 

Enables protection against optical drive buffer underrun. 

Buffer underrun protection is enabled by default. We recommend 
that you leave this check box selected. 

Check box 
Streaming 

Streaming can more than double the write speed. However, it can 
have a negative effect on the quality of the disc, since the disc is not 
checked during the burn process and defective sectors are not re-
written. 
This check box is cleared by default, in other words verification is 
enabled. If this check box is enabled, verification will be disabled for 
DVD-RAM and Blu-ray discs.  

Check box 
Direct overwrite 

If this check box is selected, rewritable discs will be directly overwrit-
ten without having to delete old data first. 
If this check box is cleared, a dialog box will notify you when a disc 
containing data is inserted for writing. 

Check box 
Burning an image 

file 

If this check box is enabled, Nero DiscSpeed will run through the 
Create data disc test by creating an image file (ISO or NRG). 
If this check box is cleared, Nero DiscSpeed will run through the 
same test by burning binary data until the maximum capacity of the 
disc is reached. 

Check box 
Include test data 

If this check box is selected, additional information about the test 
(information on the optical drive, the installed firmware, and the burn 
process graph) will be burned to the disc. 

 

See also 
  Transfer rate → 14 
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14.4 Access/Seek Times Navigation Entry 
The Access/Seek Times navigation entry offers setting options in the Measure and Num-
ber of operations areas specifically for the Access/seek times test. 

 
Nero DiscSpeed - Options - AccessSeek Times navigation entry 

The following setting options are available: 

Area 
Measure 

Defines which of the two tests will be run - Access times or 

Seek times. 

Input field 
Number of operations 

Defines how many times the selected test is run. The higher 
the value that you enter, the more accurate the measurement 
result is. However, the duration of the test becomes longer if 
the test is repeated often. The test is run 100 times by default. 

 

See also 
  Access/Seek Times → 16 
  



Nero DiscSpeed Options Window 

 Nero DiscSpeed 60 

14.5 Save Navigation Entry 
Under the Save navigation entry you can specify a storage location and file name that are 
automatically selected if you have enabled the Autosave feature. 

 
Nero DiscSpeed - Options - Save navigation entry 

The following setting options are available: 

Check box 
Autosave 

If this check box is enabled, Nero DiscSpeed will automatically 
save all test results, either in CSV or in HTML format. 

Check box 
Include status 

If this check box is enabled, Nero DiscSpeed will not only save 
the graph, but also all additional information appearing in the 
display area. 

Check box 
Show file dialog 

If this box is checked, an appropriate dialog box will open be-
fore the file is saved. Here you can choose a file name and 
specify where the file is to be saved. 
If this box is not checked, then all files will be automatically 
saved in the specified folder. The file name is automatically 
created. 

Button 
 

Opens the Find Folder window. Here, you can specify the 
folder in which the file should be saved. 
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Input field 
 

Creates file names based on the following user-defined para-
meters: drive name, drive version, date, time, and MID (Me-
dia Identification Code). 
You can compile the parameters in any order. Arrange all the 
parameters you want in the input field. 
If all parameters are cleared from the input field, the file name 
cannot be automatically generated. 
Only works if the Show file dialog check box is enabled. 

 

See also 
  Saving Test Data → 47 
  

14.6 Autorun Navigation Entry 
You can configure detailed settings for the autorun feature under the Autorun navigation 
entry. 

 
Nero DiscSpeed - Options - Autorun navigation entry 

The following check boxes are available: 

Start selected tests 
automatically 

Automatically starts the series of tests selected under the 
Standard Tests navigation entry as soon as a disc is in-
serted in the optical drive. 
If this check box is cleared, the test series must be manually 
started. 
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Check at startup if Auto-
Run is enabled 

Starts Nero DiscSpeed displaying a message window when 
AutoRun is disabled. You can enable AutoRun here. 

Continuously run selected 
tests 

Defines how many times the tests selected under the Stan-
dard Tests navigation entry will be run. 
The following options are available if this box is checked: 
Delay between test runs - Defines the length of the delay 
between two test runs. 
Number of test runs - Defines how many times the tests will 
be repeated. If the value selected is 0, the tests will be re-
peated until you manually stop them. 

 

See also 
  Standard Tests Navigation Entry → 54 
  

14.7 Disc Quality Entry 
The Disc Quality navigation entry offers setting options for the quality test in the General, 
QuickScan, Diagram Margins and Colors. 

 
Nero DiscSpeed - Options - Disc quality navigation entry 
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The following check boxes are available in the General area: 

Detect speed settings The speed the Disc Quality is tested, can change with the 
choosed optical drive. The speed is connected to the recorder 
model and the installed firmware. If the check box is active, Nero 
DiscSpeed automatically detects the speed, as soon as the Disc 
quality tab in the main screen is selected. If this box is not 
checked, the speed must be manually detected. 

Show error limits Shows the intervals in the diagram of the graphical representa-
tion in colored graduations. 
Depending on the optical drive model and the intervals at which 
they occur, detected errors can be classed at a glance as per-
missible, tolerable, or unacceptable. 

Show statistics Shows a statistical overview of the results at the end of the test. 

Show disc label Shows the disc label on the Disc Quality tab. 
 

In the QuickScan area you can define the options for the quick scan. The Disc Quality 
could be executed as complete scan. You can choose between the quick and the full scan 
on the Disc Quality tab. The quick scan only checks defined points on the disc. All other 
areas are ignored. As a result, it requires less time than a complete scan but is less accu-
rate.  

Measure points Defines how many points on a disc will be checked during the quick 
scan. 

Sample Length Defines the size of each scan point in MB. 
 

In the Graph limit area you can define the maximum scale limits for the graphical represen-
tation of the error curves. The following setting options are available: 

Option button 
Automatic 

Automatically adapts the graduated scale values to the number of 
errors measured. A value of 10 is defined as the initial value for both 
C1 Errors/PI Errors and for C2 Errors/PI Failures. 
If more errors are found, Nero DiscSpeed automatically adapts the 
scales to the higher value. 

Option button 
Locked 

Defines the maximum values on the scales as locked. Enter the 
values you want in the C1 Errors/PI Errors and C2 Errors/PI Fail-
ures text boxes. 

Selection area 
Maximum CD speed 

Defines the maximum value that will be displayed in the C1 Er-
rors/PI Errors curve for write and read speeds. 
This value is separately defined for CDs and DVDs. 
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In the Colors area you can define the colors on the Disc Quality tab in the main screen. 
The following setting options are available: 

Menu 
Theme 

Selects the desired theme. In addition to predefined themes, you can 
also set colors with the costum entry. To manually edit a color, click 
the colored tile and select the color you want in the dialog box that 
appears. 

Button 
Background 1 

Changes the basic color in the background of the graph area. 

Button 
Background 2 

Changes the basic color for shading in the background of the graph 
area. 
Only works when the Background 2 check box is enabled. Otherwise, 
the background of the graph area is displayed in one single color. 

Button 
Grid (primary) 

Changes the colors for the coarse grid in the graph area. 
Only works when at least one of the following check boxes is enabled: 
Show horizontal grid and/or Show vertical grid. 

Button 
Grid (secondary) 

Changes the color for the fine grid in the graph area. 
Only works when at least one of the following check boxes is enabled: 
Show horizontal grid and/or Show vertical grid. 

C1/PIE Line signifying the C1 errors/PI errors in the graph. 

C2/PIF Line signifying the C2 errorsPI errors in the graph. 

Jitter Representation of Jitter in the graph. 

Read speed Line signifying the Read speed in the graph. 

Write speed Line signifying the write speed in the graph. 

This curve will only be displayed if the Include test data box has been 
checked under the Transfer Rate navigation entry. 

Check box 
Show horizontal 

grid 

Shows the horizontal grid lines in the graph area or hides them. This 
box is checked by default. 

Check box 
Show vertical 

grid 

Shows the vertical grid lines in the graph area or hides them. This box 
is checked by default. 
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14.8 Capture Navigation Entry 
The Capture navigation entry offers setting options for saving test results with the help of the 
snapshot feature. 

 
Nero DiscSpeed - Options - Capture navigation entry 

The following setting options are available: 

Check box 
Show file dialog 

If this box is checked, an appropriate dialog box will open be-
fore the file is saved. Here you can choose a file name and 
specify where the file is to be saved. 
If this box is not checked, then all files will be automatically 
saved in the specified folder. The file name is automatically 
created. 

Menu 
Picture format 

Defines the file format in which snapshots are saved. Formats 
BMP, PNG, JPG, and TIFF are available. 

Button 
 

Opens the Find Folder window. Here, you can specify the 
folder in which the file should be saved. 

Input field 
 

Creates file names based on the following user-defined para-
meters: drive name, drive version, date, time, and MID (Me-
dia Identification Code). 
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You can compile the parameters in any order. Arrange all the 
parameters you want in the input field. 
If all parameters are cleared from the input field, the file name 
cannot be automatically generated. 
Only works if the Show file dialog check box is enabled. 
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15 Technical Information 
  

15.1 System Requirements 
Nero DiscSpeed is installed along with its suite. Its system requirements are the same. You 
can find more detailed information on the system requirements under www.nero.com. 

  

  16-bit Windows compatible sound card and speakers or headphones 
  Optional: CD recorder 

http://www.nero.com/�


Glossary 

 Nero DiscSpeed 68 

  

16 Glossary 
  

A-BEX-Disc 
An A-BEX disc is a test DVD that is used to test the error correction of an optical drive. For 
that purpose, the test DVD already comes delivered with defects such as scratches or fin-
gerprints.  
  

Access Time 
The access time is the time a drive needs to move the read head to a specific position on the 
disc that is inserted in the drive and to additionally read an area of the disc. In other words, 
the access time encompasses the seek time and in addition the period of time for reading a 
specific area. 
  

Blu-ray 
Blu-ray technology refers to burning on special data carriers. In comparison to DVD's, which 
use a red laser in order to read and write data, Blu-ray discs are written with a blue laser. 
The shorter wavelength (405 nm) of this blue laser makes it possible to position the laser 
with greater accuracy. Data can be written in a more compact manner and takes up less 
space on the disc. A Blu-ray disc can store up to 25 GB on a single layer disc and up to 50 
GB on a dual layer disc. 
  

Book Type 
The book type defines the specification (e.g. DVD-, DVD+, DVD-ROM) of a DVD. In order to 
ensure correct playback, the DVD specifications are defined in books so that all media can 
be read correctly. The specifications are defined in the so-called Rainbow Books, which are 
distinguished by means of their color (e.g. Yellow Book). 
  

Buffer 
A buffer refers to temporary memory that records and delivers data that cannot be processed 
immediately as required. The buffer also allows for continuous data flow. 
  

C1 errors 
A C1 error describes the error rate on the lower layers of a burned CD that are automatically 
corrected during reading. Every recordable disc features these errors; the fewer they are, the 
better the quality. 
  

C2 errors 
A C2 error describes the error rate on the lower layers of a burned CD that are automatically 
corrected during reading. Every recordable disc features these errors; the fewer they are, the 
better the quality. High C2 error rates indicate burn problems or quality flaws. 
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CD Text 
CD Text consists of additional information on a CD that can store e.g. music track titles and 
artists. CD Text is stored in the so-called lead-in area of the CD before the audio data starts. 
The display on the CD player shows the additional data. You must have a CD burner which 
supports CD Text to enable the CD Text to be written to a CD. In particular, CD Text can 
only be written in disc-at-once mode.  
  

CPU usage 
The central processing unit processes a computer's processes. The higher the computing 
performance, the higher the load of the CPU and its performance. 
  

DAE quality 
DAE (Digital Audio Extraction) refers to the process of reading audio files with a drive. DAE 
quality indicates how well a drive reads data on a CD. 
  

Disc type 
Disc type refers to different optical storage media with different specifications. The best 
known are CD's and DVD's that can be written to once or multiple times, and which are 
manufactured with different storage capacities.  
  

Dual Layer Disc 
A dual layer disc refers to a DVD that uses two layers on one side, which increases its sto-
rage capacity. 
  

DVD-RAM 
Digital Versatile Disc Random Access Memory is the first rewritable data carrier format de-
veloped. It is characterized by a distribution of sectors that makes it possible to achieve in-
creased data integrity, quicker formatting, and improved error management in comparison to 
DVD+/-RW.  
  

Dye type 
There are different materials of different colors that are used to produce storage media. The 
laser-sensitive and data-carrying dye layer can e.g. be made of phthalocyanine or formazan. 
  

Firmware 
Firmware is software that has been installed on hardware during production (e.g. recorder, 
USB device, etc.). It is used for communication between the respective hardware and other 
software, e.g. when a USB device is connected to a PC.  
  

Jitter 
Jitter refers to an abrupt and undesired change in the signal characteristics. Small gaps oc-
cur in the data stream as a result. Audio correction synchronizes the data by overlapping the 
sectors. This way, the gaps are not audible. 
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Lead-in 
The leadin is the starting area (innermost area) of user data on a data carrier. This is where 
the table of contents and additional information concerning the disc is stored. 
  

Lead-out 
The leadout is the ending area of user data on a data carrier that is used to close a session. 
If the disc has not been completed yet, the reference for the next session is stored here. 
  

Multisession Disc 
A multisession disc can contain several sessions that are not fixed. This way, more data can 
be added in new sessions at a later point in time, and the disc is not closed until it is full. 
  

On-the-fly 
The name on-the-fly describes a burn process for discs. In this process, data is written to the 
disc directly from an image. 
  

PI Errors 
Parity of inner code is part of the structure of a DVD's data block, and is used for error cor-
rection purposes. If a PI in a DVD cannot be read, one speaks of a PI error. 
  
  

PO Errors 
The parity of outer code is part of the structure of the data block of a DVD and is used for 
error correction purposes. If a PO on a DVD cannot be read, one speaks of a PO error. 
  
  

Read Speed 
The read speed of a drive is a factor of the speed that the laser needs in order to read the 
data on an optical storage medium, e.g. 8x or 16x speed. 
  

Ripping 
Ripping refers to the process of extracting audio or video data from an optical storage me-
dium onto a computer's hard drive in order to process it. 
  

Rotational speed 
Discs can be read and/or burned in different ways. As a general rule, the reading process in 
optical drives starts at the radius of the disc and moves from the center outwards. The two 
standards used to define the types of rotational speed are linear velocity and angular veloci-
ty. With constant angular velocity, the tracks at the center of the disc always travel at the 
slowest linear velocity. The linear velocity increases as you move away from the center to-
wards the outer edge. Angular velocity (also called rotational speed) describes the change in 
the rotation angle over time independently of the radius of the disc, i.e. the velocity at which 
an object loops a sector. 
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RPM 
Revolutions per minute (RPM) is an English unit that is used in mechanics to represent rota-
tional speed. It indicates the number of complete revolutions per minute. 
  

Search Time 
The seek time is the time the drive needs to move the read head to a specific position on the 
disc that is inserted in the drive. In other words, the seek time encompasses the period of 
time between the arrival of a write or read command and commencement of the actual write 
or read process. 
  

Sector 
A sector is the smallest addressable information unit on a CD-ROM. A sector is composed of 
2,352 bytes, of which - depending on the type of CD used - different amounts are available 
as user data. A sector generally consists of a header, synchronization bits and user data. It 
may also have error recognition and correction data. 
  

Streaming 
Streaming refers to the continuous transmission of data that can already be played during 
the transmission procedure. This means that it is not necessary to wait until a media file has 
been transmitted completely before it can be played back. A TV channel can be received 
and displayed at the same time without it first having to be saved to the hard drive. 
  

Subchannel data 
Subchannel data on a disc contains additional information, such as CD Text or information 
on positions. 
  

Write Speed 
The write speed indicates the speed at which a drive can write data to the optical storage 
medium, e.g. 8x or 16x speed. 
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18 Contact 
Nero DiscSpeed is a Nero AG product. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Nero AG 

Im Stoeckmaedle 13  Internet: www.nero.com 

76307 Karlsbad  Help: http://support.nero.com 

Germany  Fax: +49 724 892 8499 
 

 
Nero Inc. 

330 N Brand Blvd Suite 800  Internet: www.nero.com 

Glendale, CA 91203-2335  Help: http://support.nero.com 

USA  Fax: (818) 956 7094 

  E-mail: US-CustomerSupport@nero.com 
 

 
Nero KK 
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 Internet: www.nero.com 
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